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REPORT SUMMARY 

 
Numerous studies have characterized residential and occupational exposures to electric and 
magnetic fields (EMF). Exposure to contact current may also occur in environments with EMF 
exposures.  This report provides documentation for the use of a contact current meter (CCM) 
developed to personally monitor such exposures. 

Background 
A contact current occurs at home or in the workplace when a person touches two conductive 
surfaces that are at different electrical voltages. Typically, currents flow from hand to hand or 
from a hand through the feet, depending on how the contact with the conductive surfaces was 
made. The range of current which may flow within a person can vary depending upon a number 
of different parameters, including the resistance of the superficial layers of the contacting skin 
and body dimensions. Residential and occupational exposure to contact current has not 
heretofore been characterized. 

Objectives 
To design a Contact Current Meter to record an individual’s exposure to contact currents and 
provide a better understanding of the frequency, magnitude, and environments in which 
individual contact current exposure occurs; to document the use of the meter. 

Approach 
The project team considered several design options and developed the Contact Current Meter 
based on the concept of recording potential differences across locations on the body and 
determining current flow based on body impedance estimates or calibration techniques. In the 
latter method, a test current of known value produces potential differences that determine 
impedance. 

Results 
The Contact Current Meter is a portable, battery-powered device that can be worn by a person.  
Medical electrodes attached to an individual’s arm and legs allow current flow within the body to 
be monitored and recorded by the meter as the person goes about their daily routine. Data 
collected by the meter can then be downloaded to a personal computer for analysis. 

Preliminary testing of the CCM indicates that contact current exposures may occur in both home 
and work environments. Limited testing has been performed in a laboratory, and a new study is 
utilizing the meter on individuals working in a variety of different electrical occupational 
environments.  
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EPRI Perspective 
EPRI research has identified contact current as an exposure with potential relevance to EMF 
health effects issues. When the magnetic field issue came to prominence in the late-1980s, EPRI 
supported the development of the EMDEX personal meter and other exposure instruments and 
software products such as the EMF Workstation. With the advent of interest in contact current, 
the CCM offers the opportunity to obtain exposure data in real time. At present the meter is 
being deployed in a study of electric utility employees at an EPRI EMF Health Assessment 
program-member company. Results from this study, co-funded with EPRI by the National 
Institute for Occupational Safety and Health (NIOSH), are anticipated in 2003. 

Keywords  
Electromagnetic fields 
Contact current  
Contact current meter  
EMDEX 
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1  
INTRODUCTION 

The EPRI Contact Current Meter (CCM) is a portable device worn by a human subject which 
detects and records power-frequency voltage differences between various parts of the subject’s 
body. 

The meter monitors the voltage differences using sensors located on the arms and legs of the 
subject.  The contact current data are stored as a binary file on a removable compact flash card 
and transferred to the PC using a compatible card reader.  The data are viewed using the Contact 
Current PC Software. 

 

 

Figure 1-1 
The EPRI Contact Current Meter with sensor cable assembly  
(adhesive sensor connectors not shown) 
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The Sources of Contact Currents 

For a number of reasons, many conductive surfaces in environments with AC power have small 
AC voltages relative to other conductive surfaces.  These voltages can be caused by different 
electric fields in the area of electrically isolated conductive surfaces.  For example, metal objects 
under transmission lines can have a voltage difference relative to each other because of the 
presence of the electric field generated by the line.  The North American power system uses a 
three-wire power plug with a live, neutral, and grounding wire in residences and offices.  For 
safety reasons the grounding wire is usually connected to the conductive surfaces of appliances 
and the neutral at the electric service entrance.  Ground currents in metallic water pipes, poor 
connections in the grounding conductors, and incorrectly wired or floating appliance conductors 
can lead to differences in voltage on different surfaces.  These voltage differences have been 
called “open circuit voltages” (Voc) [1]. If a person in this environment touches two or more of 
these surfaces, a conductive path is established through that person’s body and small leakage 
currents can flow through the body between the different conductive surfaces.  These are called 
“contact currents”.  The amount of current is a function of the resistance of the current path and 
the voltage. 

Contact currents in residential environments with a Voc of 0.5 V and a 10,000 ohm contact path 
will result in a 50 µA contact current. This can occur under a number of different circumstances 
where Voc’s exist. 

In transmission and distribution line environments, there will always be some body currents due 
to the electric field caused by the lines.  In most cases, these are very small unless the electric 
field is high (greater than 100 V/m) or the resistances are small (less than 10,000 ohms at 50/60 
Hz). A body current of ~100 µA will be generated in an ungrounded person standing in a 10,000 
V/m electric field with no direct electrical connections [2].  Note: this body current may not meet 
the full definition of contact current; since the human is only making “capacitive connections” 
[1].  However, in all functional details the current will act like a contact current and be measured 
by the CCM. 
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2  
USING THE CONTACT CURRENT METER 

Before You Begin. 

You will need the following: 

• The EPRI Contact Current Meter. 

• Contact Current Meter Sensor cable assembly. 

• At least five (5) self-adhesive medical electrode patches with snap connectors.  See  
Appendix E for more information on electrodes. 

• Alcohol wipes. 

• Four (4) AA alkaline batteries. 

• One formatted compact flash card. 

• A PC with a compact flash card reader and the Contact Current Meter software. 

• Fanny pack/carrying case. 

 
Figure 2-1 
Contact Current Meter user interface and connectors. 
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Overview 

1. Install four  (4) AA alkaline batteries in the meter (see page 4-1). 

2. Insert the compact flash card into the flash card port. 

3. Attach the sensors to the subject (see page 3-1). 

4. Attach the sensor cable connector to the meter sensor port. 

5. Turn on the power to the meter.  The display shows the following screens: 

• Contact <Program Version Number> 

• Battery <Battery level percentage> 

• Please Wait… 

6. At the Begin Logging? display, do one of the following: 

• To begin collecting data, skip to Step 8. 

• To adjust the sensor threshold voltage levels, press Up Menu. 

7. At the Setup Levels display, do the following to set the threshold sensor voltage 
levels: 

A. Press Enter to set up the first of four data channels. 

B. At the RA-LA <Threshold> display, press Increase to increment the voltage 
threshold or press Decrease to lower the threshold.  When the desired level is 
reached, do one of the following: 

• Press Down Menu to go to the next channel. 

• Press Up Menu to go to the previous channel. 

• Press Escape to exit and return to the Begin Logging? display. 

8. At the Begin Logging? display, press Enter to begin collecting data.  The meter 
displays Logging when it is collecting data. 

9. To stop data collection, press the STOP DATA Collect button on the side of the 
meter.  The button is recessed to protect it from being accidentally pressed so a pencil 
or pointed probe is needed. 

10. Turn the meter off and remove the compact flash card to transfer the data file to a PC 
and view the data using the Contact software (see page 7-1). 
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3  
ATTACHING THE SENSORS 

Before You Begin 

To attach the sensors to the subject, you will need the following: 

 The Contact Current Meter sensor cable assembly. 

 At least five (5) self-adhesive electrodes with a snap connector that fits the end of the sensor 
cables. 

 Several alcohol wipes. 

Step One: Finding the Best Location for the Sensors 

Sensors are placed in the following general areas: 

• One on the right arm or shoulder. 

• One on the left arm or shoulder. 

• Two on the right leg. 

• One on the left leg. 
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Figure 3-1 
General sensor placement 

Follow these guidelines to find the best location: 

 The sensor wires must be covered under the subject’s clothing at all times for the safety of 
the subject.  This helps prevent accidentally snagging the wires and pulling the cable from 
the electrode. 

 Place the electrodes as far down the arm or leg as you can while keeping the sensor wires 
under the subject’s outer clothing.  For example, if the subject is wearing a short-sleeve 
garment, place the sensor pad as far down the limb as the garment covers.  Moving the 
electrodes as far down the limbs as possible increases the resolution of the CCM. 

 Select a flat area of healthy skin that is the size of the pad and is clean and relatively free of 
hair.  Do not select places where the skin flexes or where there is a crease in the skin. 

 Consider the activities of the subject and select an area where it is least likely that the subject 
will bump or rub the sensor against something and an area where the electrodes can be worn 
comfortably. 

 Select an area that is firm enough to press the sensor cable against the pad and snap the cable 
to the pad.  For example, look for areas above bones, muscles, or firm tissue. 
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The following figures illustrate suggested sensor locations for subjects wearing long or short-
sleeve clothing: 

 

 
Figure 3-2 
Suggested sensor placement for subject wearing long-sleeved clothing. 
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Figure 3-3 
Suggested sensor placement for subject wearing short-sleeved clothing. 

Step Two: Attaching the Electrodes to the Subject 

Do the following for each sensor pad site you selected in Step One: 

1. Clean the site with an alcohol wipe and allow it to dry. 

2. Peel the backing off the pad and carefully lay it flat on the subject’s skin. 

3. Place your finger near the snap and trace a spiral pattern with your finger on the adhesive 
portion of the electrode.  This prevents any wrinkles and makes firm contact of the adhesive 
to the skin.  This also insures good electrical contact with the skin. 

Step Three: Attaching the Sensor Cables to the Electrodes 

Note: It is easier to do this procedure if the Sensor Cable is not connected to the CCM. 

1. Place the Sensor Cable connector about where the subject will be wearing the CCM. 

2. For each of the color-coded cables, do the following: 
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A. Thread the cable underneath the subject’s outer clothing and outside 
underclothing to the sensor pad indicated in Table 3-1. 

Table 3-1 
Sensor cable color and placement 
 

Sensor cable color Attach the cable to 
the sensor pad on: 

Red Right arm 

White Left arm 

Blue Left leg 

Green Right leg 

Black (uncolored) Right leg 

 

 
Figure 3-4 
Sensor placement by cable color code. 
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About the Sensors 

The Contact Meter monitors the voltage between the four sensors.  If the voltage in any of the 
Red/White, White/Blue, or Red/Green sensor pairs reaches or exceeds their threshold level, the 
three pairs of voltages are sampled for 512 ms at a 0.5 ms rate.  These data are then processed by 
the meter. 

The threshold voltages are independently settable for four channels through the keypad prior to 
starting data collection. 

Each pair of sensors is monitored through a separate channel. If the sensors are placed according 
to the instructions below, each channel monitors the voltage difference between the parts of the 
body as shown in Table 3-2 below. 

Table 3-2 
CCM sensor channels 

Channel Sensor Pair Monitoring: 

RA-LA Red/White Right and left arms 

LA-LL White/Blue Left arm and left leg 

Bias Red – White/Black Body bias current used to keep 
sensors in range. 

RA-RL Red/Green Right arm and right leg 
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4  
INSTALLING BATTERIES 

The CCM requires four (4) AA sized batteries.  The batteries are in a compartment opened from 
the back of the meter.  To install the batteries: 

1. Turn the meter over so you are facing the back of the meter. 

2. Press on the grooved depression on the battery compartment cover marked “open” (Figure  
4-1). 

 
Figure 4-1 
Battery compartment cover on back of meter 

3. Slide the cover toward the bottom of the meter as you continue pressing on the grooved 
depression. 

4. Install the batteries correctly with regard to the “+” and “-” terminals. 

5. Slide the cover up until it snaps into place. 
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The batteries can be used between 15-40 hours depending on the number of data sets written to 
the CompactFlash card.  If data sets are being written to the card frequently, the demand on the 
batteries is much greater than when there are fewer data sets written.  The CCM uses a hardware 
and software filter to limit the events recorded to those of interest to the user.  These filters are 
discussed in Adjusting Sensor Thresholds on page 6-1. 
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5  
USING COMPACTFLASH CARDS 

The Persistor CompactFlash card is a non-volatile memory card containing three files used 
by the CCM to store the following: 

• The data collected by the CCM (contact.dat). 

• The last sensor channel thresholds stored by the user (trigger.sav). 

• Various signal processing variables and settings (contact.ini). 

If the  trigger.sav and contact.ini files do not exist on the card, the CCM creates them with a set 
of default values (see Appendix C – CCM Default Values). 

If the contact.dat file exists, additional contact current data are appended to the file. 

The card is inserted in a slot located on the right side of the CCM.  The card is cleared of data by 
deleting the contact.dat file.  This should be done after each data collection when the existing 
data have been safely stored and backed up on the PC. 

NOTE: The Windows operating system sometimes delays deleting files from the card.  After you 
have issued a command to delete a file, refresh the view of the card’s directory to verify that the 
file has been erased. 

NOTE: If the contact.dat file is not erased, new measurements taken with the CCM are 
appended to the file. 

The data file is transferred to a PC equipped with a flash card adapter.  The card appears to the 
Windows operating system as a disk drive and the data file can be copied to the desired folder.  
The data file is then converted and processed using the CCM Windows software. 
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Figure 5-1 
CompactFlash card 

Formatting CompactFlash Cards 

Under certain circumstances it is desirable to reformat the flash card.  For example, if the format 
on the card becomes corrupted, you must reformat the card.  The CCM can format flash cards 
using an internal program: 

1. Turn off the power to the CCM. 

2. Insert the flash card in the card slot on the right side of the CCM. 

3. Turn on the power to the CCM while holding down the upper right key.   

 

 

Figure 5-2 
Flash card format key 
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After showing the program version number and the battery condition, the display shows 

Erase? 
YES/NO 

Press Yes to format the card and clear all data collected, the saved threshold levels in the 
trigger.sav file, and the signal processing variables and settings in the contact.ini file.  If 
you press No, any data you collect are appended to the existing data on the card. 

NOTE: If the CCM cannot find the trigger.sav and contact.ini file on the card, it writes these 
files with default values. 

4. If you pressed the Yes key,  Please wait… appears on the display for several seconds 
while the card is formatting.  When the format is finished Card is Erased! appears. 

5. After a few seconds, Ready or Run Setup appears when the procedure is complete. 

NOTE: Although the flash card could be formatted in an adapter while using Windows 95/98 
software, we recommend using the CCM to format the cards to insure full compatibility with the 
CCM software. 
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6  
ADJUSTING SENSOR THRESHOLDS 

The CCM uses two filters to control the level and type of contact currents it detects and records.  
These filters allow the CCM to make best use of memory and battery resources: 

1. The first filter is a peak detector.  The CCM ignores currents below a user-settable hardware 
threshold value.  The input thresholds are initially set to 0.8 µA but are adjustable to values 
from 0.0 to 1000 µamp (based on a 500-ohm body resistance).  The threshold values to the 
three input channels can be independently adjusted (see Table 3-2). 

2. The CCM is designed to capture contact currents and uses a  Goertzel filter to determine the 
power-frequency component of the current.  This filter calculates the average signal energy at 
a particular frequency contained in a specified portion of the captured data.  The CCM then 
excludes events whose power-frequency component falls below a preset level (see  
Appendix B – Goertzel Filter Settings). 

The hardware threshold is checked first.  For many users a hardware threshold setting of 1.6 µA 
or greater for each channel is sufficient.  The software filter is set to a default of 1.2 µA so it 
accepts signals greater than 1.2 µA.  However, for other situations, adjusting the software filter 
may be helpful. 

The two most common conditions that warrant adjusting the software filter are low level 
measurements and environments with significant electrostatic discharge (ESD).  The lowest 
increment for the hardware threshold is 0.8 µA.  For any setting below 6 µA, instrument noise 
can cause false triggers that quickly fill memory.  Collecting data with thresholds set at these low 
levels often requires adjusting the thresholds of the software filter. 

ESD currents can occur up to tens of amperes at frequencies much higher than the CCM 
bandwidth.  The CCM hardware frequency filters eliminate the majority, but not all, of these 
currents.  ESDs cover a wide frequency range and some can appear in the CCM bandwidth.  
Using the software filter greatly enhances the CCM selectivity for reducing ESDs captured by 
the meter (see Appendix B – Goertzel Filter Settings). 

Determining Hardware Current Threshold Levels 

The CCM has settable hardware threshold levels for all three input channels up to 1000 µA on 
the inputs and 4.16 µA on the bias channel. 

1. If you wish to capture all events within the sensitivity of the CCM, the CCM can be set for 
continuous data collection by setting the thresholds to 0.0 µA.  This causes the CCM to 
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continuously trigger.  In this case, the software filter controls the amount of data collected.  If 
the software filter is also set to zero, the meter continuously collects and stores data.  At that 
rate, a 32 MB flash card fills with data in about three hours. 

2. If you are collecting data for a longer time period or wish to limit the data collected, you 
must use a discrete non-zero threshold value.  To determine the threshold value for the input 
channels, first choose the minimum current value you need to record., then do the following: 

A. Look at Figure 6-1.  Determine whether the arm electrodes are in the area shaded as area 
1 (elbow to wrist), area 2 .(bicep), or area 3 (shoulder/collar)  Then determine whether 
the leg electrodes are closer to area 4 (upper thigh to knee) or area 5 (knee to ankle). 

 

 
Figure 6-1 
Sensor areas for adjusting channel thresholds. 

B. If the arm electrode is in area 1 and the leg electrode is in area 4, do the following: 

i. Multiply your minimum current threshold by 0.08.  This is the value you will set for 
the RA-LA channel. 

ii. Multiply your minimum current threshold by 0.05.  This is the value you will set for 
the LA-LL and RA-RL channels. 
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C. If the arm electrode is in area 1 and the leg electrode is in area 5, do the following: 

i. Multiply your minimum current threshold by 0.08.  This is the value you will set for 
the RA-LA channel. 

ii. Multiply your minimum current threshold by 0.08.  This is the value you will set for 
the LA-LL and RA-RL channels. 

D. If the arm electrode is in area 2 and the leg electrode is in area 4, do the following: 

i. Multiply your minimum current threshold by 0.04.  This is the value you will set for 
the RA-LA channel. 

ii. Multiply your minimum current threshold by 0.03.  This is the value you will set for 
the LA-LL and RA-RL channels. 

E. If the arm electrode is in area 2 and the leg electrode is in area 5, do the following: 

i. Multiply your minimum current threshold by 0.04.  This is the value you will set for 
the RA-LA channel. 

ii. Multiply your minimum current threshold by 0.06.  This is the value you will set for 
the LA-LL and RA-RL channels. 

F. If the arm electrode is in area 3 and the leg electrode is in area 4, do the following: 

i. Multiply your minimum current threshold by 0.01.  This is the value you will set for 
the RA-LA channel. 

ii. Multiply your minimum current threshold by 0.02.  This is the value you will set for 
the LA-LL and RA-RL channels. 

G. If the arm electrode is in area 3 and the leg electrode is in area 5, do the following: 

i. Multiply your minimum current threshold by 0.01.  This is the value you will set for 
the RA-LA channel. 

ii. Multiply your minimum current threshold by 0.05.  This is the value you will set for 
the LA-LL and RA-RL channels. 

3. We recommend setting the Bias channel threshold to 4.16 µA.  This value disables the CCM 
from triggering on this channel and will only collect data when a threshold is reached on the 
three input channels (see The Body Bias Current Threshold on page 6-7). 

4. Record the modified thresholds for all four channels for use in the next procedure. 
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Adjusting Sensor Thresholds 

1. Using the procedure in Determining Hardware Current Threshold Levels above, find the 
desired threshold levels for all four channels A-D. 

2. From the Begin Logging? display on the CCM, press Up Menu. 

3. In the Setup Levels display, press Enter. 

4. In the RA-LA display, do one of the following: 

A. Press Increase to increment or Decrease to decrement the threshold value to the 
desired level for this channel you determined in Determining Hardware Current 
Threshold Levels above. 

B. Press Down  Menu to go to the next channel. 

C. Set the threshold value as described above.  Continue setting for all four thresholds. 

D. Press Escape to save the thresholds for all channels and return to the Begin Logging? 
display.  

 

Body Resistance and Sensor Placement 

NOTE: This section is not needed to operate the CCM; it provides material for understanding the 
relationship between body resistance and sensor placement. 

The amount of current that passes through the body depends on the voltage applied across the 
body and the amount of electrical resistance the body has against electric current flow.  
According to Ohm’s law, the voltage (V), resistance (R), and current (i) are related by the 
formula: 

iRV =  

Thus: 

• Greater voltages across the body result in higher currents. 

• Greater electrical resistance in the body results in lower currents. 

The unit of electrical resistance is the ohm.  The ohm is defined as the resistance needed to 
produce a current of one Ampere when an electrical potential of one Volt is applied. 

The electrical resistance of the body is not evenly distributed; different parts of the body have 
different resistances  Figure 6-2 shows the distribution of electric resistance across various 
sections of the body.  Suppose, for example, that a subject’s electrical resistance from their hand 
to their foot was 500 ohms.  According to Figure 6-2, 32.3% or 161.5 ohms of that resistance 
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would be contributed by the path from the foot to the knee.  Similarly, the electrical resistance 
from the hand to the elbow would contribute another 26.4% or 132 ohms. 

Resistance or Impedance? 

Impedance is the more accurate term to describe the resistance of the body to an AC current.  
The impedance of a current path is the “resistance” to current flow and is a function of AC 
frequency.  Since the term “resistance” is more commonly used; it is used in the meter labeling 
and documentation.  In this manual, the term resistance is used; although, impedance is the 
technically correct term. 

 
Figure 6-2 
The distribution of electrical resistance across the body [3]. 

The CCM assumes a body resistance of 500 ohms from wrist to ankle for an adult male.  The 
actual resistance may vary according to several factors such as body size, weight, and whether 
the subject is male or female.  From Ohm’s Law, the resistance affects the current passing 
through the body for a given voltage. 

The CCM can be adjusted to ignore currents below a given threshold on three paths across the 
body and the body bias current: 

• From the right arm to the left arm 
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• From the left arm to the left leg 

• From the right arm to the right leg 

• Body bias current 

The size of the currents detected by the CCM is affected by the total resistance between the two 
sensors the CCM is measuring.   

 This means that, in general, the closer two sensors are to each other, the lower the resistance 
and the less sensitive the threshold detectors are to currents flowing between them. 

Calculating Threshold Levels 

In many measurement situations, you do not know the body resistances of the subject when the 
CCM is used.  However, threshold levels are a function of body resistances.  The hardware 
threshold levels were designed as a means of controlling how much data are collected to make 
best use of memory and battery resources rather than as a means of specifying precise detection 
levels.  Body resistances can vary due to factors including the subject’s height, weight, body 
type, gender, and age.  Placement of the electrode is also a significant factor in the resistance as 
seen in Figure 6-2.  Since the resistance and, therefore, the detected threshold levels, can vary 
widely, the desired threshold levels must be modified as described in the section Determining 
Hardware Current Threshold Levels. 

If electrodes are not placed at the ankles and wrists, the body resistance decreases as shown in 
Figure 6-2.  This affects the threshold levels.  For example, if the electrodes are placed on the 
bicep and mid-thigh, the resistance across the electrodes is significantly  reduced compared to 
the resistance from the ankle to the wrist.  Therefore the voltage seen between those electrodes 
for threshold detection is correspondingly reduced.  From Figure 6-2, the percentage resistance 
from the bicep to mid-thigh is: 

9.9% (shoulder to chest)  + 1.3% (chest to abdomen) + 5.1% (abdomen to thigh) = 16.3% 

To take into account variations between individuals and the exact placement of the sensors, this 
value is further adjusted by multiplying by 0.20: 

16.3% * 0.20 = 3.26% 

Therefore, the adjustment factor for a desired threshold, based on a 500-ohm wrist-to-ankle 
resistance, is 0.03. 

To measure a 5 µA threshold for wrist to ankle measurements when the electrodes are placed on 
the bicep and thigh, the recommended threshold for those channels (LA-LL and RA-RL) is: 

5 µA * 0.03 = 0.15 µA 
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The Body Bias Current 

Note: We recommend that the threshold of the Bias channel be set to 4.16 µA. 

Hardware specifications of CCM components require that the voltage difference between the 
ground potential of the instrument and the subject stay within a certain range to operate correctly.  
The CCM adjusts this voltage difference and keeps it in range by introducing a very small 
current (0 to 1.67 µA) through the black bias current cable.  The amount of current flowing 
through this cable is recorded in the Bias current channel. 

The Body Bias Current Threshold 

In addition to the user-settable threshold on the three input channels, a body bias current 
threshold can be set.  This captures a data set when the body bias current is above that threshold. 

You can disable this threshold by setting it higher than 4.16 µA.  Since the CCM can supply 
body bias currents up to 1.67 µA, the CCM will never trigger on this channel when the threshold 
is higher than 4.16 µA. 

Additional characterization remains to be done on this channel.  At present, most users should 
leave this channel threshold disabled (the default condition). 
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VIEWING THE DATA ON A PC 

The CCM uses a CompactFlash memory card to store the data and some runtime parameters.  
The measurement data are stored in a binary file called contact.dat.  You must have a PC with a 
compact flash card reader to transfer the data to a local drive. 

The CCM monitors each of its four channels for an event meeting the following criteria: 

• The current on any channel is above the user-settable threshold value. 

• The power-frequency component of the event is above a preset minimum energy determined 
by the Goertzel filter algorithm. 

• The Goeztel threshold is enabled for that channel. 

If an event occurs which meets all criteria, the CCM samples the voltage of all four channels 
1024 times in a 512 millisecond period and writes the voltage vs. time data to a dataset in the 
contact.dat file on the CompactFlash card. 

The data file on the flash card is examined and converted to other file formats using the Contact 
Windows software. 

Before You Begin 

You must have the Contact Current Meter Windows Software installed on your PC.  If the 
software is not installed on your system, obtain a installation CD-ROM and follow the 
instructions while running the setup program. 

Recommended system requirements for the Contact software: 

• Windows 95, 98, NT, 2000. 

• Pentium 3, 800 MHz processor or equivalent. 

• 256 MB RAM recommended for large data sets. 

• 200 MB free disk space.  Large data files require more disk space. 

Transferring the Data File to a PC 

1. If the CCM is collecting data, press the STOP DATA Collect button on the side of the 
meter.  The button is recessed to prevent accidental presses.  Use a pencil or pointed probe to 
press the button. 
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2. Turn off the CCM 

3. Grasp the CompactFlash card and gently pull it out of the slot on the CCM. 

4. Insert the flash card in the card reader on the PC. 

5. Open Windows explorer and click on the flash card reader icon. 

6. Drag the contact.dat file to a local drive. 

7. Rename the file with a meaningful name. 

Opening the Flash Card Data File 

1. Double-click on the Contact icon to open the program. 

2. In the Contact main window, set the electrical resistance of the subject by doing the 
following: 

A. Click File > Set Default Body Resistances. 

B. In the Default Body Resistances dialog box, enter the resistance of the subject for 
each of the pathways. 

3. To load in the flash card data file, click File > Import CompactFlash Card Data… 

4. In the Open dialog box, browse to the folder containing the .dat flash card data file and click 
on the file to select it.  Click Open. 

Note: Large data files can take several minutes to load depending on your PC’s capabilities. 

After the data file is loaded, the data of the first data set in the file are shown as in Figure 7-1. 
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Figure 7-1 
Contact Windows software main screen. 

Notice the following features on the screen: 

• The number of the dataset is displayed on the bottom of the window.  Each data file contains 
one or more datasets, one for each contact current event stored by the CCM. 

• The current vs. time plot is displayed for one or more channels recorded by the CCM. 

Selecting the Contact Current Paths Displayed 

Using the Chart Toolbar on the left side of the program window, the contact currents along the 
following paths can be selected for display by clicking on that button: 
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Selecting the Data Set Displayed 

Thousands of individual data sets, each representing a contact current event, can reside in a 
single data file.  Do one of the following to display a particular data set: 

• Use the tool bar to parse through the data sets: 

 
• Click View then click one of the following to move through the data sets: 

– Select DataSet to jump to a specific data set. 

– Select First DataSet to jump to the first data set. 

– Select Last DataSet to jump to the last data set. 

– Select Previous DataSet to go to the previous data set. 

– Select Next DataSet to go to the next data set. 

Viewing Data Set Properties 

Several properties and settings of individual data sets can be viewed and changed.  Click Edit > 
Dataset Properties to open the Dataset Properties dialog box.  You can change any of the 
following: 

• The data set label 

• The resistance along the following pathways: 

– Right arm – left arm (RA-LA) 

– Left arm – left leg (LA-LL) 

– Right arm – right leg (RA-RL) 

– Right arm  - left leg (RA-LL) 

– Left arm – right leg (LA-RL) 

– Body bias current (Bias) 

• The data channels displayed.  The display is also changed using the Chart Toolbar. 

• Display of event markers. 

The following additional properties are displayed: 

• The CCM program version. 
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• Date and time of the data set. 

• Length of the data set in milliseconds. 

• Crest and average RMS current values for each channel. 

• RMS value for each channel for each sample. 

• Threshold levels set in the CCM for each CCM channel. 

Selecting and Viewing a Region of Interest 

You can select a region of interest (ROI) based on the number of milliseconds from the 
beginning of the data set.  Once the ROI is defined, you can expand the time axis to show only 
the ROI. 

To define the ROI, do the following: 

1. In the Contact main window, click Tools > Select Region. 

2. In the Select Region of Interest dialog box, enter the Starting Time and Ending Time 
defining the ROI in milliseconds. 

3. Click OK.  The charts automatically adjust the time axis to show the ROI. 

To cancel the ROI view, do one of the following: 

• In the Contact main window, click Chart > Reset Zoom. 

• Click the  button on the Chart Toolbar to show the entire data set. 

Adjusting the Time Axis 

Use the Chart Toolbar on the left side of the program window to customize the time axis display. 
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Adjusting the Current (Vertical) Axis 

To adjust the vertical axis on a specific graph, do the following: 

1. Click anywhere in a graph you want to adjust.  The data line plot becomes bold when it is 
selected. 

2. Use the Chart Toolbar on the left side of the program window to customize the time axis 
display. 

 

3. To change the scale to its maximum setting, click Chart > Reset Y Axis. 

Inserting Event Marks in the Data Set 

You can mark and label various times in a data set with event marks.  These marks show up as a 
label and a thin vertical line on the plot: 

 
Figure 7-2 
Contact Windows software main screen showing event mark. 
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To insert or edit event marks, do the following: 

1. In the main screen, Click Tools > Edit Event Marks. 

2. In the Event Markers dialog box, enter the time of the event relative to the beginning of the 
data set in the input boxes indicated in Figure 7-3, then click Add Event.  Click OK. 

 
Figure 7-3 
Event marker dialog box. 

3. To modify an existing event mark, click on the desired event mark and modify the 
information in the input boxes.  Click OK. 

4. To delete an existing event mark, click on the desired event mark and click Delete Event.  
Click OK. 

5. To show or hide marks on the screen, click Visible.  Click OK. 

Exporting Summary Data by Channel and Data Set 

To export the data file in comma-separated-variable (csv) format, do the following: 

1. In the main screen, click File > Export ASCII. 

2. In the Open dialog box, browse to the folder to receive the data.  For Name, enter the name 
of the exported data file.  Click Save.  The following data are exported per dataset per 
channel:: 

• Data set name. 

• Correction factor: resistance for each body pathway used to calculate the contact current. 

• Time of the event. 
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• Path (channel): the path along the body along which the current was measured. 

• Duration of the event in milliseconds. 

• Crest Value of the current in µA. 

• Average RMS current in µA. 

Exporting the Raw Data File 

The Contact program creates a comma-separated-variable representation of the data file when the 
file is opened.  This csv file is deleted when you exit the program or rewritten if you open a 
different data file.  To save this file for later use, do the following: 

1. Click out of the Contact program and browse to the same folder containing the data file you 
opened. 

2. Find the file named Output and make a copy. 

3. Rename the copied output file and add a .csv extension. 

The file contains  

• General header information for the data file. 

• Data for each data set.  Each data set is preceded by the date the data were collected and 
threshold information. Contact current data for each of the three CCM channels.  The units of 
the data are: 

– Sample: Samples are taken every 0.5 mS. 

– Channels A, B, D: Each unit represents 0.2 mV.  For example, a value of 100 
corresponds to 20 mV.  To convert this value to a current, divide the voltage by the 
resistance for that channel.  The resistances for that data set are found in the Dataset 
Properties dialog box (see page 7-4).  For example, suppose channel A (right arm to 
left arm) had an resistance of 500 ohms.  A value of 100 in the column for channel A 
corresponds to 20 mV which corresponds to 0.4 mA contact current for that sample. 

– Channel C: Each unit represents 1.67 nA of bias current.  For example, a value of 100 
represents 0.167 µA of bias current. 
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TECHNICAL SPECIFICATIONS 

Dimensions....................................7.72” x 3.94” x 1.57” (19.6 cm x 10.0 cm x 4.0 cm) 

Weight ...........................................15.0 oz (425 g) 

Software.........................................Embedded operating program controlling hardware and user 
interface 
 
PC: Windows 95, 98, and NT-based charting, analysis, and 
export program 

Data Storage ..................................Compact flash memory cards 1.69” x 1.43” x 0.14” (4.29 cm x 
3.34 cm x 0.35 cm). 
 

Capacity: 20-600 MB. 

Display...........................................8-character, 2-line LCD 

Controls .........................................3x3 keypad 
 

Power on/off: slide switch 
 

Stop data collection: momentary push button 

Ports...............................................3.5 mm stereo (3-conductor) serial port jack 

Input Channels...............................3 

Input Channel Current Range........0 to 10 µA at 500 ohms 

Data Set Trigger Thresholds..........Programmable on 3 channels: 0 to 1000 µA. 

Frequency Range...........................24-220 Hz: 0, -3 dB (typical) 

Power Requirements......................Voltage: 3.4 - 9.5 V 
 

Power: 1.0 watt (typical) 

Backup Battery ..............................Lithium 3V 

Battery Life Indicator Levels ........6.0V=100% 
3.3V=0% 

Sample Rate...................................0.5 milliseconds (2.0 KHz) for 0.5 seconds. 

Operational Life ............................15-40 hours @ 25°C using four AA alkaline batteries.  Battery 
life depends on the number of contact current events recorded. 

Voltage Measurement Accuracy ...±3% 

Operating Temperature Range ......32 to 158°F (0 to 70°C)

0



0



 

B-1 

B  
GOERTZEL FILTER SETTINGS 

The Fast Fourier Transform (FFT) transforms a signal from the time-domain to a frequency-
domain that determines the contribution of different frequencies to the overall spectrum of the 
signal.  The Goertzel filter is an algorithm similar to the FFT that provides an efficient way to 
determine the contribution of a single frequency component to the spectrum of the signal. 

The CCM uses a Goertzel algorithm as a software bandpass filter to capture contact currents 
falling within a narrow frequency window.  The CCM also has four independent threshold values 
allowing the user to ignore events below a settable current.  The Goertzel filter allows the user to 
set the instrument to fairly low thresholds and still collect up to eight hours of data using fresh 
alkaline batteries and an empty data file on a 32 Mb CompactFlash card. 

The Goertzel filter is controlled by variable settings in the contact.ini file on the flash card.  If 
the contact.ini file is not found on the card, the CCM writes one with the variables and settings 
found in Table B-1. 

These settings can be changed by placing the card in a flashcard adaptor on a PC and changing 
the settings using a text editor.  The CCM will use the new settings when the card is replaced in 
the flash card slot and turned on. 
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Table B-1 
Goertzel filter settings in the compact.ini file. 

Variable Default Channel Comment 

ENERGY_THRESHOLD_CHANNEL_RA_LA 94229 Right arm – 
left arm 

ENERGY_THRESHOLD_CHANNEL_LA_LL 94229 Left arm – 
left leg 

ENERGY_THRESHOLD_CHANNEL_BIAS 94229 Body bias 
current 

ENERGY_THRESHOLD_CHANNEL_RA_RL 94229 Right arm – 
right leg 

Energy threshold at 
the 
DTMF_FREQUENCY 
for storing the data 
set. 

FILTER_LENGTH 200 All Number of data 
points to use in filter 
algorithm (max 
=1024). 

FILTER_OFFSET 0 All Begin the filter 
calculation from this 
data point in the data 
set (0-1023). 

DTMF_FREQUENCY 60 All Bandpass frequency 
in Hz. 

CHANNEL_RA_LA_FILTER 1 Right arm – 
left arm 

CHANNEL_LA_LL_FILTER 1 Left arm – 
left leg 

CHANNEL_BIAS_FILTER 0 Body bias 
current 

CHANNEL_RA_RL_FILTER 1 Right arm – 
right leg 

1 = Use the filter on 
this channel. 

0 = Do not use the 
filter on this channel 

 

The threshold energy for each channel is calculated using the following formula: 

4

22ML
E =  

Where: 

E = The value compared to the ENERGY_THRESHOLD_CHANNEL variables in Table B-1. 

L = FILTER_LENGTH 

M = Average analog to digital (A/D) value in the portion of the data set determined by 
        FILTER_LENGTH and FILTER_OFFSET. 
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The A/D value is the raw integer value from the channel analog to digital converter.  For contact 
current limits the calibration is: 

bitmVohmsA 12.05004.0 ==×µ  

For example, to set a current limit of 2 µA = 5 bits.  Calculating E above yields 250,000.  
Therefore, 2 µA limit in the Goertzel software filter requires a value of 250,000 for each 
ENERGY_THRESHOLD variable in Table B-1.  This assumes a resistance of 500 ohms.  If the 
current path resistance is different, the E value must be adjusted. 

No precise calibration or accuracy characterization has been made for the body bias channel.  
Our best estimate is that each bit is equivalent to 0.5 V/m for the 
ENERGY_THRESHOLD_BIAS_CHANNEL variable.  This means that 100 V/M gives a value 
for E of 400,000,000.  We do not recommend the use of this threshold at this time because of the 
lack of adequate characterization and calibration. 
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CCM DEFAULT VALUES 

The CCM uses the contact.ini and trigger.sav files on the CompactFlash card to store runtime 
parameters.  If these files are absent from the card, the CCM creates them with a set of default 
values. 

The contact.ini file is an ASCII file containing the default Goertzel filter settings described in 
Table B-1, Appendix B – Goertzel Filter Settings. 

The trigger.sav file is a binary file containing the hardware thresholds for the four data 
channels.  The values in the file are modified when adjusting the sensor threshold through the 
CCM interface (see Adjusting Sensor Thresholds, page 6-1).  Do not try to modify this file 
except through the CCM interface. 

Table C-1 
Default settings in the trigger.sav file. 

Current path Default 
(Ohms) 

Channel 

Right arm – left arm resistance 500 RA-LA 

Left arm – left leg resistance 500 LA-LL 

Body bias resistance 500 Bias 

Right arm – right leg 500 RA-RL 

0



0



 

D-1 

D  
CCM MENU STRUCTURE 

LA-LL
<Threshold>

Contact
<Version No.>

Battery
<Level>%

Begin
Logging?

Setup
Levels

RA-LA
<Threshold>

Bias
<Threshold>

RA-RL
<Threshold>

Saving
New Lvls

Logging

Decrease

Increase

Increment threshold

Decrement threshold

Turn on power

STOP DATA
Collect (button)

changes?
Any

Up MenuDown Menu

Enter

Up Menu Down Menu

yes

no

Enter

Escape

Collect and Log
Sensor Data

Up Menu Down Menu

Up Menu Down Menu
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E  
ELECTRODE SUPPLY SOURCES 

The CCM requires electrically conductive connections to the body at five points.  The 
connections need to meet the following criteria: 

• Provide a constant resistive connection to the body with a DC resistance of less than 150,000 
ohms (preferable much lower). 

• Provide some method of remaining attached to the body for the duration of the measurement 
period. 

• Provide a compatible connector to the "snap connector" used on the CCM cable assembly. 

• Is comfortable to wear for the duration of the measurement period. 

• Does not cause any allergic reaction to wearer's skin. 

Medical ECG electrodes meeting these criteria and are inexpensive and readily available.  There 
are three manufacturers that we have identified: 

ConMed Corp 
310 Broad Street 
Utica, NY 13501 
1-800-448-6506 
http://conmed.com/products_ECGelectrode.html 

3 M Health Care 
(1-888-364-3577) 
http://products.3m.com/us/healthcare/products/healthcare- 
prof.jhtml?powurl=GSJY2NKSF9beGS2PVC6H4DgeGST1T4S9TCgvGSBJP234N1gl 

Vermont Medical, Inc. (Vermed) 
Industrial Park 
Bellows Falls, VY 05101-1556 
1-800-245-4025 
http://www.vermed.com/ 

Enertech has used two ConMed products in an occupational study, the model 1700-005 and 
1870-030.  There are many different models available and each is intended for a particular 
application or environment.  We have used the 1700-005 on office workers in indoor 
environments.  The 1870-030 has a stronger adhesive and is made for environments where the 
subjects perspire more heavily (diaphoretic).  Users should choose electrodes that are optimized 
for their environment and are readily available.  Local medical supply stores carry these 
electrodes or can order them.
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RESISTANCE MEASUREMENTS ON A SMALL SAMPLE 
OF MALE SUBJECTS 

Tests were run to measure resistances in a small sample of adult males.  The subjects were 
outfitted with meters.  A test fixture created low-level, fixed contact currents.  Operation and 
body resistance levels were measured.  Table F-1 contains the results. 

Subject heights varied from 5’ 1” to 6’; and weights varied from 126 lbs to 280 lbs.  At least five 
different current path resistances were measured for each individual.  Several individuals were 
tested for a sixth resistance and one individual was measured before and after an hour of 
vigorous exercise.  Plotting the resistance on a two dimensional graph can create a model 
template of resistances verses height and weight.  This template can be used to determine 
estimated resistances for other test subjects. 

Table F-1 contains the results of a small limited experiment to test the system.  A full health 
study would warrant a larger systematic examination of the resistance relationship; however, the 
results of this test give an indication of expected resistances. 
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Table  F-1 
Impedance test of seven individuals with a fixed current of 10 microamps. 

Electrodes placed at mid-bicep and ¾ the distance between ankle and knee. 

Subject Height Weight Arm to 
arm 

Left arm 
to left leg 

Right arm 
to right leg 

Right arm 
to left leg 

Left arm 
to right 
leg 

Right arm 
to left leg 

Comment 

1 5’10” 160 lbs 133 Ohms 211* 
Ohms 

218* Ohms 199* Ohms 224* 
Ohms 

239* 
Ohms 

 

2 5’8” 230 105 162 168 166 166   

3 5’11’ 155 161 204* 207* 204* 209* 232*  

4 5’5’ 126 155 296* 310* 290* 302* 390*  

5 5’1” 145 129 211 211 208 219 239  

6 6’ 280 131 177 175 179 174 180  

7a 5’8” 185 118 183 181 186 178  Before exercise 

7b 5’8” 185 118 180 174 180 178  After 1 hour of 
exercise 

* Measurements made from mid-bicep to the ankle and then scaled to ¾ the distance from the ankle to knee using the impedance 
model in Reilly [3] 
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